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About 13.2 Release

Statistica 13.2 is a minor release with new features and functionality.

Statistica is a flexible analytics system, which allows users to create analytic workflows that are packaged and
published to business users. Users also interactively explore and visualize problems.

Users can also create and deploy statistical, predictive, data mining, machine learning, forecasting,
optimization, and text analytic models.

Organizations gain the ability to manage the entire analytical lifecycle, data aggregation and preparation,
data visualization and discovery, model creation, model deployment, and model monitoring, with the
Statistica Enterprise Server. In addition, this product line provides governance controls to work within
regulated environments.

New Analytic Bundles

We have restructured our analytic products (bundles). New customers are currently purchasing the new
analytic bundles, which comprise Professional, Expert Manufacturing, and Expert Data Science and Enterprise.
Over the next year, existing customers will migrate to these new analytics bundles as they purchase new term
licenses or renew their maintenance on their perpetual licenses.

To help with this transition, the release notes will contain the old analytic bundle names. Customers who own
the new bundles will need to review the following table before reading the release notes. It maps the old
bundles (Statistica Advanced), which have new features, to the new bundles (Statistica Professional).

Table 1 New Bundles

Statistica Statistica Statistica Statistica
Professional Expert Expert Data Enterprise
Manufacturing Science

Statistica Advanced X X X X
Statistica Industrial Statistics X X X X
Statistica Rules Builder X X X
Statistica Enterprise Small add-on add-on add-on

Business Edition or Statistica
Enterprise Server

Deprecated Features

The features in the following list are no longer supported, starting with Statistica 13.1. Customers under
maintenance who need time to transition to a replacement product may request licensing for deprecated
products until August 31, 2017 for everything except Statistica Scorecard.

Table 2 Deprecated Features

Product Change

Statistica Small Business Edition Customers with this product will receive the replacement product
Statistica Enterprise Server.

Desktop Data Entry (SDAT) Customers with this product will receive the replacement product
Statistica Data entry Server. Desktop Data Entry, which is started
from the Statistica application, is an add-on module for the
Statistica Enterprise Server product. The last version containing the
Desktop Data Entry product is 13.1.
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Product Change

In-database Analytics Starting with 13.1, this feature’s licensing will change. Customers

under maintenance who own Statistica Data Miner 13.0 plus
Statistica Enterprise Server will be migrated to the new licensing.
The feature will be licensed with the Statistica Enterprise Analytics
Bundle and Statistica Enterprise Server.

Statistica core licensing Performance will no longer be limited for the client application by
cores.

Automatic Data Collection This tool does not have a replacement product.

Statistica Scorecard Customers should email info@scorecard.solutions to purchase

Scorecard. Dell Statistica no longer sells this product.

New features

All Products

Workspaces now have Designer View and User View. You will see these buttons on the workspace’s
toolbar and on the Edit ribbon bar. The Designer View allows the workspace creator to control which
options can be seen/changed, default values, required/optional. Select the Edit > Enable User View
ribbon bar so that the limited user view is displayed when double clicking on nodes.

When users select Home - New - Workspace ribbon bar, they will be asked to select a template. A
template may contain a subset of nodes for a specific problem, and/or the limited user view may be
turned on. Workspace templates for common tasks can be created and saved in C:\Program
Files\Dell\Statistica 13\DataMiner\Templates.

Workspaces can now be protected so that no one can open them, and they become a “black box.”
Select the Edit - Publish Protected ribbon bar. These protected workspaces can be executed from the
Execute External Workspace node.

A new node was added to set case states on spreadsheets. The node is located in Data > Cases > Set
Case States ribbon bar. The user can color code cases, hide rows from graphs and include with an
analysis, exclude data rows from analyses, and include in graphs.

The Write Spreadsheet to Database node can now write into Access, MySQL, Oracle, PostgreSQL, SQL
Server, SQL Server PDW and Teradata.

New nodes with added integration with Algorithmia and Apverta app marketplaces are located on the
Big Data Analytics ribbon bar.

Users can now create Code Nodes for R, Python, SVB and C#. These nodes have a designer view and
user view. Look at the bottom of the Code Node for << or >> to switch between these two views.

Statistica Advanced

Design size increased to 2,000 predictors for main effects models for General Linear Models,
Generalized Linear/Nonlinear Models and General Regression Models modules.

Multiple Correspondence Analysis (MCA) provides users with the ability to explore the connections
between rows of data and categorical variables. This functionality was enhanced to deal with larger
datasets.
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Statistica Industrial Statistics

e The new Bayesian nodes added on the Statistics = DOE ribbon bar enable users to locate regions
within the design space with a high probability of meeting certain quality standards. These nodes were
tested and validated with R 3.2.1. R must be installed for these nodes to function.

e The By Group functionality for Attribute Charts has a new option to select a Sample Label variable.
This option was already available in Statistics > QC Charts ribbon bar, and the only change is in the
interactive Batch By Group rather than in the node. To see this functionality:

e Open a spreadsheet.
e Select Statistics > Batch By Group ribbon bar.

e Select Industrial Statistics and Six Sigma - Quality Control Charts - Attribute Charts (C, U, Np,
p)-

e Select the Variables button and chose a Sample Label for the X-Axis.

Statistica Rules Builder

Trace XML can be generated using the option in "Rules” when running/executing a workspace in Interactive
mode. The ImportRules tag now contains the following version information for a rule:

e Latest_revision_date
e latest_revision

e  Approved_revision

Statistica Enterprise Small Business Edition or Enterprise
Server

e The new caching option decreases the amount of time needed to open/close/edit workspaces and
other objects stored in Enterprise Manager when it is used with the Statistica Document Management
System. This performance improvement is useful for designing complex workspaces. The new enable
caching option can be found in the Enterprise Manager application on the System Options > SDMS
Integration property page.

e As mentioned above, workspaces now have Designer View and User View.

e Users designing a workspace will work in the Statistica application and then deploy the
workspace to Enterprise.

o (itizen data scientists will then log into http://[server-name]/webstatistica and execute the
workspace. They will see one tab per visible node. After selecting variables, graph types,
statistics, etc., the user then executes the workspace to see the results.

¢ As mentioned above, workspace templates can now be saved in Enterprise Manager. The location of
the template folder in the Enterprise Manager application is set in System Options - Miscellaneous
property page.

¢ As mentioned above, workspaces can now be protected. If a customer owns Statistica Enterprise
licensing they can publish these protected workspaces to Enterprise Manager. These workspaces can
only executed by the Execute External Workspace node.

e Defining the inputs and outputs for the Execute External Workspace has been made simpler:

e Open any example workspace and right click on the data node. The popup menu has two new
options: Input Node or Output Node. Select the Input Node option.

e Right click on a node that generates results, and select the Output Node option.
e (Create a new workspace and add the Execute External Workspace.

e Double click to open the node. A new checkbox to use the defined input/output node displays.

Statistica |



http://[server-name]/webstatistica

e SQL Criteria can be commented out in the Ad hoc analysis node.

Data Entry Server

e Creating Data Entry Setups, and Labels and Characteristics has now been made easier. These objects
can be bulk exported into an Excel spreadsheet. These objects can also be bulk created via the import
process. This new functionality is available in the Statistica application on the Enterprise ribbon bar.

e Automatic labels now support calculated formulas.

Live Score Server
e  Cross-Origin Request Sharing (CORS) is now supported.

Monitoring and Alerting Server

e Calculated variables are now supported for the alerting dashboards.

Network Analytics Server

Network Analysis is sold with the new Enterprise Analytic Bundle and Statistica Enterprise Server. As this
version is a beta release of the product, see Known Issues below. The improved user interface and new
features offer a better Network Analytics experience:

e Convert data sources to networks.

e Drill-down and visualize the network, based on filtering conditions, to visualize the actors and edges of
interest.

e Score the network and writeback the score to the database to score newly added data to the network.

e Create a workspace node to score, cluster, and perform anomaly detection for the network and use
the data downstream.
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Resolved Issues

The following is a list of issues addressed in this release:

Table 2 Resolved issues

Resolved Issue Issue ID Category

Category title's font, font size and color for Categorized Graphs 92767 Graphs

can be edited.

Outlying observations downstream spreadsheet now identifies 103976 Stability and shelf life
the batch. analysis

New checkbox named Graph Objects on View menu added. 105436 Regression Tree Models
When a tree graph is open, select this option to always display

statistics when hovering mouse over a tree node.

SQL Server data types (varbinary, image, hierarchyid) were 106201 Enterprise Manager
incorrectly displayed when Explore Data button selected on a

Data Configuration. Now correct.

Test Connection button to dialogs for creating new ADO.NET 106633 General

data connections added.

WebStatistica no longer displays blank in timestamp variable 106709 Statistica Server
when selecting View Statistica Server Spread Editor through a

data configuration.

Automatic labels now supports date/time label. 106805 Data entry Server
Spreadsheet’s default cache size changed to 2048 KB for 64-bit 106813 Spreadsheet
installations.

In-Database Lasso Multiple Regression works with 500 variables 106833 In-database analytics
dataset on Apache Hive.

Left join now works with Query Spreadsheet node: Issue started 106918 Statistica Query

in Statistica 13.0.

CSV import can handle over 150,000 variables. 106945 Spreadsheet

Cases with missing values for the split variable are now 106969 Regression Tree Models
classified in the non-terminal node.

Nodes can now select variables that use “|” in the variable 106988 Workspace

name.

Python nodes can now be created on Japanese OS. 107046 Code Node

ETL node runs on Citrix server. 107079 Workspace

Upper boundary option for Histograms now uses regional 107100 Graphs

settings.

The option “mark subset” in the Scatterplot node works 107193 Workspace
correctly, issue started in Statistica 13.1

DTDATEDIFF formula auto calculates when leaving field on web 107282 Data entry Server
form.

Performance in creating new objects for large metadata 107396 Enterprise Manager
databases is improved.

Stacked graph, for a data series containing missing data, 107563 Graphs

correctly display.

Formula DTNOW-[Date Variable Name] returns an Integer value. 107713 Spreadsheet
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Known Issues

The following list of issues were known to exist at the time of release, and includes those attributed to third-
party products:

Table 3 Known issues

Known issue Issue ID

The Python node looks for any installations of Python that are present 106673
in the PATH environment variable, and displays those as available

Python environments. Once you have created a Python node with any

version of Python, save it, then send it to someone else, that user must

use the same version of Python or they will get an error message at

runtime.

Recommended versions of Python include 3.5.1 and 2.7.11. Also
recommended is Panda 0.18.1 for the extension functions. The
comtypes module is required for Python integration.

1.  When the Python node is run, sometimes an “unexpected error
loading Statistica library...” may be encountered, due to issues
with the comtypes library. Clearing temporary file cache and
comtypes file cache should resolve the issue.

2. With a small fraction of Statistica datasets, the extensions
ActiveDataSet, spreadsheet, and RouteOutput do not function
properly. Exporting and importing via CSV is a possible
workaround for such datasets.

While Network Analytics was designed to manage and analyze multi- NW1
modal networks with more than one actor class (to analyze airport
arrival/departure data with Actor Classes Flight Origin, Flight

Destination, and Airline), the ETL process for converting data stored in
relational databases or text files into network graph representations is
complex. Networks with one or two Actor Classes are easily specified as

Edge Lists; however, higher numbers of Actor Classes require careful

data preparation. At the present time, we recommend that you contact
Statistica for advice and guidance for addressing analytic requirements
requiring more than two Actor Classes.

To avoid ambiguities with Network Analytics, we recommend importing ~ NW2c
graph network data (edge lists) only when the Relationships contain no
duplicates.

Network Analytics Properties (weights) for Relationships in a uni-modal  NW3
Edge list can be defined, but not Properties of Actors; consider:

1 2 3
Origin | Destination
Alrpart Alrport Property

ORD ABE 1
ORD AR 2
ORD TLIL 3

In this case of a uni-modal network (all Actors are Airports), we are not
guaranteed that the a Property value - if arbitrarily assigned to the
Actor (Airport) in the first column -- will be assigned to every Actor
(Airport). This can happen when an Actor (Airport) only appears in the
second column as a Destination Airport but never in the first column as
an Origin Airport.

When clustering, Network Analytics for multimode networks displays a NW4
simplified solution of the network. This displays only the main
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Known issue

Issue ID

connections between actors. The same simplified display also occurs

with Anomaly Detection.

System Requirements

Before installing or upgrading to Statistica 13.2, ensure that your system meets the following minimum

hardware and software requirements.

We recommend the 64-bit version of Statistica with 64-bit processor and operating system. If the 32-bit
version of Statistica must be used, we recommend running it in a 64-bit environment for better performance.

Statistica Single User or Client Workstation

Table 4 Minimum hardware requirements for standard client configuration

Requirement Details

Processor 500 MHz, 32-bit version of Statistica requires processor
support for the SSE2 instruction set

Memory 4 GB RAM

Hard disk space for installation 10 GB

Minimum Scratch/Temporary Disk Space

Operating system

50 GB recommended per user

Microsoft Windows™ Vista

Table 5 Recommended hardware requirements for standard client configuration

Requirement Details
Processor 2.0 GHz, 64-bit, quad core or more
Memory 4 GB RAM or more

Hard disk space for installation
Minimum Scratch/Temporary Disk Space

Operating system

10 GB
50 GB recommended per user

Microsoft Windows™ 8 or above

Table 6 Recommended hardware requirements for advanced analytics configuration, including Data

Mining applications

Requirement Details
Processor 2.0 GHz, 64-bit, quad core or more
Memory 8 GB RAM or more

Hard disk space for installation
Minimum Scratch/Temporary Disk Space

Operating system

10 GB
50 GB recommended per user

Microsoft Windows™ 8 or above
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(i) |NOTE: The optional advanced hardware graphics support for transparency requires:

o Windows 7 or Windows Vista SP2 with the “Platform Upgrade” system update
e A graphics card that supports Direct2D

Statistica Enterprise Server Database Sizing

Statistica Enterprise Server requires deployment of a metadata database schema on an ODBC compliant
database. Most commonly, it will be deployed on the existing customer DBMS infrastructure, such as Oracle or
SQL Server. The system can also deploy SQL Server Express. It supports other DBMS systems as well.

Customers who own Statistica Enterprise Server also own licensing for the Statistica Document Management
Server (SDMS) for managing version and approval history. Installing SDMS is optional, and it has a separate
database schema, which is usually deployed to the same DBMS system where the metadata database has been
deployed.

The database sizing requirements vary on usage. The actual metadata describing the Statistica objects is
small, but the tablespace can be used to store reports and files (Excel, scripts) within the database (stored as
BLOBs), which can increase the overall size.

Table 7 Recommended metadata schema database sizing

Requirement Details
Initial tablespace 1 GB, grow 1 GB intervals
If explicit cap required 100 GB but may need to grow over time

The Statistica Document Management Server schema contains only metadata about the individual document
storage. The document storage is kept outside the database; therefore, SDMS tablespace requirements are
small.

Table 8 Recommended SDMS schema database sizing

Requirement Details

Initial tablespace 100 MB

Network Bandwidth 100 MBits/s or faster

Operating system Microsoft Windows™ Server 2012 or later

Statistica Enterprise Server

We recommend that Statistica Enterprise software be run on a server dedicated to Statistica Enterprise Server,
the Statistica Enterprise Server Web Server, the Statistica License Manager, and the Statistica Document
Management Server (SDMS), independent from any other application software.

The Statistica Enterprise Server is an analytic engine. Statistica Enterprise Server application files are stored
and Statistica Enterprise Server scripts are executed here.

In most cases, the Statistica Enterprise Server will also run the Statistica Enterprise Server Web Server, the
Statistica Document Management server (if applicable), and the Statistica License Manager, which is required
for all concurrently licensed products.

This server may be referred to as the Statistica Enterprise Application Server or Statistica Server.

Table 9 Minimum hardware requirements

Requirement Details

Processor 1 GHz, 32-bit version of Statistica requires processor support for
the SSE2 instruction set

Memory 4 GB RAM
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Requirement Details

Hard disk space for installation 10 GB

Scratch / Temporary Disk Space 50 GB or more

Network Bandwidth 100 MBits/s or faster

Operating system Microsoft Windows™ Server 2008 R2

Table 10 Recommended hardware requirements

Requirement Details

Processor 2.0 GHz, 64-bit, quad core or more
Memory 8 GB RAM

Hard disk space for installation 10 GB

Scratch / Temporary Disk Space 100 GB or more

Network Bandwidth 100 MBits/s or faster

Operating system Microsoft Windows™ Server 2012 or later

Table 11 Software requirement

Requirement Details
Microsoft Internet Information Installed and configured to run ISAPI and CGI applications
Server (lIS)

(i) |NOTE: System Requirements are based on an average size implementation.

These requirements apply to the Statistica Enterprise Server Web Server, Statistica License
Manager, and SDMS server (if applicable). If any of these are to be run on a separate server,
refer to their specific System Requirements documents.

Statistica Live Score

We recommend that Statistica Live Score software be run on a server dedicated to Statistica Live Score,
independent from any other application software. This is a transaction server.

The Statistica Live Score Server is the analytic engine that receives and executes the scoring/WebService
(SOAP) calls for Statistica Live Score.

Table 12 Minimum hardware requirements

Requirement Details

Processor 1 GHz, 32-bit version of Statistica requires processor support for
the SSE2 instruction set

Memory 4 GB RAM

Hard disk space for installation 10 GB

Scratch / Temporary Disk Space 50 GB or more

Network Bandwidth 100 MBits/s or faster

Operating system Microsoft Windows™ Server 2008 R2

Table 13 Recommended hardware requirements
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Requirement Details

Processor 2.0 GHz, 64-bit, quad core or more
Memory 8 GB RAM

Hard disk space for installation 10 GB

Scratch / Temporary Disk Space
Network Bandwidth

Operating system

100 GB or more
100 MBits/s or faster

Microsoft Windows™ Server 20 or later

(D NOTE: System Requirements are based on an average size implementation. Statistica Live Score

expected.

applications often benefit from additional cores, depending on how many simultaneous requests are

The Statistica Live Score is part of the Statistica Enterprise system. Installation of the Statistica Server
Application Server must occur prior to the installation of the Live Score Server.

Statistica Monitoring and Alerting Server (MAS)

We recommend that Statistica MAS software be run on a server dedicated to Statistica MAS, independent from
any other application software. Users will log onto a web browser to review the red light, yellow light, green
light alerts. Alerts can also be configured to be sent by email.

Table 14 Minimum hardware requirements

Requirement Details

Processor 1 GHz, 32-bit version of Statistica requires processor support for
the SSE2 instruction set

Memory 4 GB RAM

Hard disk space for installation 10 GB

Scratch / Temporary Disk Space
Network Bandwidth

Operating system

50 GB or more
100 MBits/s or faster

Microsoft Windows™ Server 2008 R2

Table 15 Recommended hardware requirements

Requirement Details

Processor 2.0 GHz, 64-bit, quad core or more, 32-bit version of Statistica
requires processor support for the SSE2 instruction set

Memory 8 GB RAM

Hard disk space for installation
Scratch / Temporary Disk Space
Network Bandwidth

Operating system

10 GB
100 GB or more
100 MBits/s or faster

Microsoft Windows™ Server 2012 or later

(D NOTE: The Statistica MAS Server is part of the Statistica Enterprise system. Installation of the Statistica
Server Application Server must occur prior to the installation of the MAS Server.
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Statistica Enterprise Server Web Server

The Statistica Enterprise Server Web Server runs the web scripting language PHP, processes the web pages
from the user, and sends them to the Statistica Enterprise Server Application Server.

Use the following System Requirements in the special situation where the web server portion of Statistica
Enterprise Server will be installed on a separate server from the Statistica Enterprise Server Application
Server.

Table 16 Minimum hardware requirements

Requirement Details

Processor 1 GHz

Memory 2 GB RAM

Hard disk space for installation 30 MB

Network Bandwidth 100 MBits/s or faster

Operating system Microsoft Windows™ Server 2008 R2 or later

Table 17 Recommended hardware requirements

Requirement Details

Processor 2.0 GHz, 64-bit, quad core or more
Memory 2 GB RAM

Hard disk space 30 MB

Network Bandwidth 100 MBits/s or faster

Operating system Microsoft Windows™ Server 2012 or later

(i) |NOTE: In most cases, the Statistica Enterprise Server Web Server will run on the same server as the
Statistica Enterprise Server Application Server. The Statistica Enterprise Server Application Server
System Requirements document includes the requirements for the Statistica Enterprise Server Web
Server.

Statistica Visualization Server

The Visualization Server can be deployed as either a 32 or 64-bit application. The Visualization Server can also
be deployed as a 32-bit application on a 64-bit OS. The query-able cache can also be deployed as a 64-bit
application, while the rest of the Visualization Server is deployed as a 32-bit application.

Typically, the choice of deployment depends on the data connectivity requirements, as only 32-bit data
sources can be accessed by a 32-bit Designer / Visualization Server.

For optimal scalability and user experience, we recommend that the Visualization Server be installed on a
Server environment. Although basic functionality works on desktops, such as Windows 7, 8, 10, etc., only

use that setup for demo purposes.

The minimum requirement of four cores supports 25 current users. Eight cores will support 50 users, and so
on.

Installation on virtualized environments

The Visualization Server can be installed on virtualized environments from various vendors, including
Microsoft, VMWare, and Amazon.

Typical considerations for a virtualized deployment include:
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e Storage of User Profile Content
e The Designer license, log, and configuration file stored in the user profile

e Virtualized resource specifications closely matched or exceeding that previously given for RAM, Hard
Disk, CPU, etc.

e Appropriate access rights granted to open ports for inter process communication

Table 18 Supported Microsoft WindowsTM operating systems either physical or virtualized

Requirement Details

Windows Vista (with IIS 8) For Development Environments Only
Windows 7 (with IIS 8) For Development Environments Only
Windows 8/8.1 (with IIS 8) For Development Environments Only
Windows 10 (with 1IS 8) For Development Environments Only

Windows Server 2008
Windows Server 2012

(i) |NOTE: The Visualization Server for .NET requires Microsoft .NET Framework 4.5 or above.

We recommend installing the IS 8 web server before installing Microsoft .NET Framework 4.5. If you
install the .NET Framework first, it may not register itself correctly with the server.

For optimal performance (such as dashboard responsiveness, update latency, etc.), the IIS 8 hosting the
Visualization Server for .NET must have WebSockets installed and enabled.

Hardware & Data Sources

Hardware requirements are intrinsically linked to the data environment into which Designer will be deployed.
Consequently, providing sizing without understanding the use case, data size, data throughput, and end client
population is difficult. The following information is included as a guide, and the exact hardware requirements
should be determined on a case by case basis.

Although we recommend that the customer dedicate a server to this software, it can also be installed on the
Statistica Enterprise Application Server.

Additionally, the requirements for data caching can significantly change the hardware specification. Designer
supports two caching layers:

e Query-able Cache
e Result set Cache

Both are used to minimize end user interaction latency when accessing underlying slow data sources. The
queryable cache caches a dataset in bulk. It can then be queried without repeatedly accessing the underlying
source. The result sets the cache,and caches the results of queries, which minimizes the database load. Both
are optional, and can be used in conjunction with each other.

e 1 x Dual Core CPU (Hyper Threaded to 4 Cores/Threads)
e 4 GB RAM (8 GB with Windows 8+)

e 2 GB Disk (Available)

e In Memory Caching limited to 3 GB RAM by default

e Disk Caching limited to available disk space

e  64-bit Designer deployments would typically have much greater than 4 GB RAM, either for the Designer
itself, or for the memory based query-able cache

Multiple servers may be deployed to support different environments (Development, Test, Staging, Production),
and for high availability.
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Development / Test
e 1 x Dual Core CPU (Hyper Threaded to 4 Cores/Threads)
e 8 GBRAM
e 4GB Disk (Available)
e In Memory, Caching limited to available Server RAM.
Small Scale Deployment
e 1 x Quad Core CPU Or Equivalent (Hyper Threaded to 8 Cores/Threads)
e 16 GB RAM
e 4GB Disk (Available)
e In Memory, Caching limited to available Server RAM
Medium Scale Deployment
e 2 xQuad Core CPU Or Equivalent (Hyper Threaded to 16 Cores/Threads)
e 32 GBRAM
e 4GB Disk (Available)
e In Memory, Caching limited to available Server RAM
Large Scale Deployment
e 4 xQuad Core CPU Or Equivalent (Hyper Threaded to 32 Cores/Threads)
e 64 GB RAM
e 4GB Disk (Available)
e In Memory, Caching limited to available Server RAM

Table 19 Data sources only available in 32-bit

Requirement Details

MS Excel Streaming

MS Access If 32-bit MS Office is installed
SAP Sybase Aleri
32-bit ODBC OLEDB Drivers

Table 20 Data sources only available in 64-bit

Requirement Details
64-bit ODBC OLEDB Drivers
MS Access If 64-bit MS Office is installed

32-bit applications are limited in memory to fewer than 4 GB of available RAM, which commonly equates to a
maximum of between 5 to 10 million rows for a wide dataset. Typically, this limitation does not apply to the
Visualization Server because:

e The underlying data repository may be disk bases.

e The underlying data repository may be running in a 64-bit process.
e The query-able cache may be running in a 64-bit process.

e Aggregated/filtered result-sets are retrieved into the Designer.

e Large datasets are caches in 1000,000 row chunks to minimize memory consumption.
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e The kdb+ based query-able cache is shipped by default as a 32-bit application, and has the 4 GB data
limitation.

A 64-bit option is, of course, available, and is typically deployed on the Server, where multiple
datasets are being cached in parallel.

In the 64-bit case, the cache is not limited to memory, and the primary limitation becomes how
quickly large data volumes can be retrieved as a data extract from the external data source.

The prerequisite for installation to support R data transforms and connectivity
e R
e R-serve
e Additional libraries, as required, for specific capabilities

The prerequisite to support Python data transforms and connectivity

e  CPython
e Pyro4.24 / 4.25 (Python Remote Data Objects)

Additional modules such as Numpy, Scipy, and Pandas, as required for specific capabilities
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Upgrade and Compatibility

Technical support can be contacted via https://support.software.dell.com.

®

IMPORTANT
The 32-bit version of Statistica requires processor support for the SSE2 instruction set.

If you have the new Enterprise analytic bundle with Statistica Enterprise Server installed, you must
obtain a new license file (stat.lic) or request an access code. Request that Network Analytics and In-
database Analytics be added via https://support.software.dell.com/licensing-assistance. After you
apply the new licensing, you can upgrade.

Download the Statistica 13.2 Full Installation https://support.software.dell.com/statistica/13.1/download-
new-releases.

Customers who have Statistica 12.0.65.4 or later installed on their computers can upgrade to 13.2. The
installer will ask if the customer wants to upgrade the installation. The customers must select the
checkbox agreeing to upgrade the older Statistica installation.

Customers with older versions must uninstall Statistica and then install Statistica 13.2. Contact
https://support.software.dell.com/licensing-assistance to request Statistica 13.2 keys.

If you own Statistica Enterprise Server Compliance, download Statistica Document Management System 1.0.7.0
(SDMS) from https://support.software.dell.com/statistica/13.2/download-new-releases.

Customers who have SDMS 1.0.6.0 installed can upgrade their installation.

Execute SDMS 1.0.7.0, which will upgrade the SDMS files.

Customers who have SDMS 1.0.2.3 or 1.0.4.0 installed can upgrade their installation.
Upgrade instructions:

1. Upgrade the Statistica installation.
Request “access code to add SDMS licensing” on https://support.software.dell.com/licensing-
assistance.

3. When you receive the access code, follow the emailed instructions on how to apply the code.

4. Execute SDMS 1.0.7.0, which will upgrade the SDMS files.

5. Copy ClientSTAT.tmp file from FlexLM server directory to SDMS server directory. The file should be
renamed to stat.lic.

6. Restart SDMS service.

Customers with other versions of SDMS will need to uninstall and then install the new SDMS.

Product Licensing

Click the following link to access detailed instructions for activating your license:

https://support.software.dell.com/statistica/kb/150908 .

Installation Instructions

Visit https://support.software.dell.com/statistica/13.1/release-notes-guides to access installation and
configuration instructions.
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More Resources

Additional information is available from the following:
e Getting Started with Statistica
e  Statistica User Forums

e Statistica Developer Network

Globalization

This section contains information about installing and operating this product in non-English configurations,
such as those needed by customers outside of North America. This section does not replace the materials
about supported platforms and configurations, found elsewhere in the product documentation.

This release supports any single-byte or multi-byte character set. In this release, all product components
should be configured to use the same or compatible character encodings, and should be installed to use the
same locale and regional options. This release is targeted to support operations in the following regions: North
America, Western Europe and Latin America, Central and Eastern Europe, Far-East Asia, Japan. It supports
bidirectional writing (Arabic and Hebrew). The release supports Complex Script (Central Asia - India,
Thailand).

About Dell

Dell listens to customers and delivers worldwide innovative technology, business solutions and services they
trust and value. For more information, visit http://www.software.dell.com.

Contacting Dell

For sales or other inquiries, visit http://software.dell.com/company/contact-us.aspx or call 1-949-754-8000.

Technical Support Resources

Technical support is available to customers who have purchased Dell software with a valid maintenance
contract and to customers who have trial versions. To access the Support Portal, go to
http://support.software.dell.com.

The Support Portal provides self-help tools to help you solve problems quickly and independently, 24 hours a
day, 365 days a year. In addition, the Support Portal provides direct access to product support engineers
through an online Service Request system.
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The Support Portal enables you to:
e Create, update, and manage Service Requests (cases)
e View Knowledge Base articles
e  Obtain product notifications
e Download software. For trial software, go to http://software.dell.com/trials.
e View how-to videos
e Engage in community discussions

e Chat with a support engineer
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Legend

A CAUTION icon indicates potential damage to hardware or loss of data if instructions are not
followed.

A | WARNING: A WARNING icon indicates a potential for property damage, personal injury, or death.

@ | IMPORTANT, NOTE, TIP, MOBILE, or VIDEO: An information icon indicates supporting information.
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